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Getting Started 

Installation 
To install the software onto your PC: 

1. Place the Actinic installation CD in your CD drive. 

2. It should automatically run. If it does not, you will need to: 

·  Click the 'Start' button in Windows taskbar and go to 
'Run'. 

·  Click 'Browse' and then go to 'D:' (where D: is your CD 
drive). 

3. Select 'setup.exe' and double click. 

This w ill start the first of the 'Installation Wizards' that will guide you 
through the set-up process. It is possible to achieve a perfectly 
satisfactory installation by accepting all the default settings suggested to 
you. Click 'Next' to take you from screen to screen, click 'Back' to take 
you to the previous screen and click 'Cancel' to abort the installation 
process. 
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Starting Actinic 
Actinic is designed to publish an online store onto the internet, and then 
receive and process orders from that store. 

It works by taking all your product data and turning it into a set of web 
pages, based on the design options you have selected. It then also 
manages all the functionality to control the shopping cart, search and 
online security at your online store. 

When you first start Actinic, you will see the following screen: 

 

If you have a license key for Actinic, enter it in the field provided and 
click 'Authorise'. 

If you are setting up a multi-user site w ith Business Plus, you will also 
need to enter a username of Administrator and a password of 
Administrator. 

If you want to evaluate Actinic then you need to select one of the 
'Evaluation Version' options at the bottom half of the window.  

·  To evaluate Actinic Catalog, Actinic Business or Actinic 
Business Plus select the 'Evaluate M erchant Product Range' 
option. 

·  To evaluate Actinic Designer select the 'Evaluate Web 
Designer/ VAR Product Range' option. 

Then select a product to evaluate and click 'Evaluate'. 

You will then see the following screen: 
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The Start Here Panel 
In the main part of the screen is the 'Start Here' panel. This is designed to 
take you through the most important areas of the software.  

 

Click on one of the buttons and it w ill open up to show more 
information: 

 

A t the bottom of each page of the Start Here panel are some links to some 
useful chapters in the main Actinic help. 
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A lso, while looking through the Start Here panels you will see some l inks 
that wil l take you straight to that related area of Actinic. 

 

A lso, if you click on the link that says 'Change the look and feel of the 
store', you will see a button to start the 'Design Wizard'. 

 

The Design Wizard is a quick way to apply a basic design to your store 
where you can set the layout and colours for the design. Give it a try to 
see what happens. If you don't l ike the basic theme it gives you, there are 
some others to choose from in 'Design |  Themes'. 

Checking Out The Example Store 
Down the left hand side of the program is the 'Content Tree'. This shows 
you the section, products, pages and information items in your store. 
Click on the '+' icons in the tree to expand a branch of the tree. 

 

Click on any item in the tree to see its details appear in the 'Details' panel 
to the right.  

 

You can also click on the 'Page Preview' panel to see how the item you 
have cl icked on wil l look in your online store. 
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Other Places To Look 
There are two other main tabs along the top of the Actinic screen: 

 

·  The 'Design' tab is where you can change the look and feel of 
your store pages. This won't be there if you are using a 
'Client' version of Actinic. There are detai ls of this in "The 
Design Tab" on page 79. 

·  The 'Orders' tab is where you manage and process the orders 
received at the store. More details on this are in "Processing 
An Order" on page 56. 

Exercise - Personalising Your Store Design 
This exercise will show you how to give the default Actinic store your 
own personal stamp. 

To begin with, you are going to run the Design Wizard to customise a 
quick new look and feel for the store. 

1. Click on the Page Preview tab at the bottom of the Content 
tab. This shows what the store looks like at the moment. You 
can get this look and feel back at any time by re-selecting the 
default 'theme' (called 'Reflective').  This is talked about later 
in "Choosing A Theme" on page 70. 

2. Look at the Start Here panel and click on the 'Design Wizard' 
button: 

 

3. On the first page, you can select whether your store design 
will have a fixed width, or shrink and grow with the browser 
window. Make a choice and then click 'Next >' to continue. 

4. On the next page, you can choose some colours for the 
different parts of the design. Select some colours (by clicking 
on the coloured boxes) and then click 'Next >' to continue. 
You can always re-run this wizard to choose some different 
ones.  
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5. On the next page you can decide whether your store has one 
sidebar down the left hand side, or a sidebar down each side 
of the design. Make a choice and then click 'Next >'. 

6. In the next few screens you can choose where Actinic will 
place things like quick search bars, section lists and best 
sellers lists. Again, you can always re-run this w izard if you 
are not happy w ith your choices.  

7. Eventually you will get to the final screen where there will be 
an 'Apply Design and Preview ' button. 

 

8. Click this button to see what effect al l your changes have had 
on the Actinic store. You w ill be taken to the Page Preview 
panel to see your new design. 

If you don't like what you see, re-run the Design Wizard or go to 'Design 
|  Themes' to choose a ready-made look and feel for your store. 

Next you are going to select a new 'Corporate Logo' image to go at top of 
every store page. 

1. Go to 'Design |  Themes'. 

2. At the bottom of the window, under where it says 'Corporate 
Logo' click the 'Browse' button and select a new image from 
your PC.  

 

This might be an image you use in letterheads, or one you 
use on an existing website. It needs to be a '*.gif' fi le or a 
'*.jpg' fi le and not be too enormous (i.e. not more than about 
600 pixels wide). 

3. Once you've selected an image, click 'OK' to use it in Actinic. 

4. Check the Page Preview panel to see how your new logo 
looks.  
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More Information - Getting Help With Actinic 
Whenever you are looking at a new area in Actinic, look out for the 'How 
Do I' buttons. 

 

 

Click these buttons to bring up a help file with link to lots of relevant step 
by step guides to using Actinic.  

 

You can access the entire A ctinic help file by going to the 'Help' menu 
and selecting 'Help Topics'. Or you can click the  button on the toolbar. 
When viewing the help, use the 'Contents' tab of the help to browse by 
topic. A lternatively, use the 'Index' or the 'Search' to locate key words or 
phrases. 

In addition, click on the question mark -  - at the top right of the Details 
panel (or any of the windows within Actinic) and then click in a field. 
You will be shown a little piece of help about the field. 
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Previewing 
Each separate section (and each brochure page) in the store will 
eventually become a single web page in your online store. 

The Page Preview panel shows you what the page you have selected in 
the content tree will look like online. If you are finding the panel too 
small, or you would like experience more of how your customers w ill see 
the site, you can always do an offline preview. This allows you to check 
out your store design in a web browser.  

There are two ways to preview 

·  Preview Current Page - Opens only the current page in a 
web browser. To do this, click the  button on the toolbar, 
go to 'Web |  Preview Current Page' or press [Ctrl + A] on 
your keyboard. 

·  Preview Store - Previews all the brochure pages and section 
pages in your store, showing you how it all fits together. To 

do this, click the  button on the toolbar, go to 'Web |  
Preview Store' or press [Ctrl + W] on your keyboard. 

Exercise - Previewing 
This exercise will step you through the two different kinds of 
previewing. 

1. Make sure you are on the Content tab. 

2. Click on any section (or brochure page) in the store and click 
the  button on the toolbar.  

3. This w ill display your page in your normal web browser. 

 

4. Now go back to Actinic and click the   button on the 
toolbar. 

5. Navigate through the sections in your store (using the links 
provided) to view them. 
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6. Try adding something to the shopping cart. You should get a 
warning message. This is because you cannot test store 
functionality with a preview - only the look and feel. 

Exercise - Previewing Other Pages 
This exercise will show you how to preview pages that are not in your 
content tree. 

1. Go to the Design tab (not available in Client versions). 

2. Locate the 'Select Page Type' drop down, which is above the 
preview panel on this tab. 

 

3. Select a page other than 'Content Page'. The page you select 
will appear in the preview panel.  

4. You can then cl ick the  button to see how this page wil l 
look in a web browser. 

If you are previewing a shopping cart or checkout page w ithin a preview 
page, it w ill contain some example data. 

More Information - The Design Tab 
The preview panel on the Design tab is different from the one on the 
Content tab as it is interactive. You can click on something in the 
preview, and the HTML code for that item will appear in the 'Layout 
Code' panel w ithin the tab.  

For more information about using the Design tab, please see the chapter 
called "The Design Tab" on page 79. 
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Products 
The whole of Actinic is effectively geared around the presentation and 
promotion of your products. Consequently there are many options 
within Actinic that change how your products look and work. With 
Actinic you can (among other things): 

·  Enter a stock level for a product. 

·  Create an extended information w indow, containing a larger 
image and/ or a longer description. 

·  Set whether the product price is shown including or excluding 
tax. 

·  Set whether a downloadable file w ill be available to customers 
who buy a product. 

·  Set up a list of related items that will appear underneath a 
product. 

·  and many more...  

Within the content tree products look like this:  

If there is a '+' next to the product, it is because that product contains 
options such as 'size' or 'colour' etc. 

Try clicking on some of the example products that are in Actinic, and 
look at the panels in the Details panel to see the sort of things you can 
configure on a product. 

Don't forget you can get information about a setting by clicking on the  
at the right of the Details panel title bar and then cl icking in a setting. 

Exercise - Adding a New Product 
1. Right-click on the 'Homeware' section in the content tree. 

2. On the right-click menu, select 'New Product'. 

 

3. Make sure you are looking at the 'General ' panel by selecting 
'General' in the list of panels to the left of the 'Details' panel. 

4. In the 'Short Description' field, enter 'Running Shoes'. 

5. In the 'Price' field, enter '50.00'. 

6. In the 'Full Description' field enter 'Pair of lightweight 
running shoes'. 
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7. In the 'Image' field click 'Browse'. You need to be in the 'Site1' 
folder. If you are not there, browse to the '...\ Sites\ Site1' 
folder on your PC.  

8. Select 'x-sneakers.jpg' from the 'Site1' folder. 

 

9. Switch to the 'Layout' panel and change the 'Price Layout' to 
'Standard Tax Inclusive Price'. This w ill mean that the price 
for this product will be displayed including tax. 

10. Click the 'Apply Changes' button. 

Your new product will appear in the content tree and also in the preview 
panel. 

Exercise - Formatting Text 
This exercise will show you how to change the appearance of the text in 
your product description. 

1. Highlight the text 'running shoes' w ithin the 'Full 
Description' field of your new product. 

2. Press the  button on the toolbar at the top of the details 
panel. 

3. Click 'Apply Changes'. 

4. This w ill make the text 'running shoes' appear bold in the 
preview. 

Feel free to experiment with the other text formatting options on the 
toolbar to see what effect they have. 

Exercise - Extended Information Windows 
This exercise will add an extended information window to your 'running 
shoes' product. 

1. Switch to the 'Extended Information' panel. 

2. Select 'Generate Pop Up Page'. 

3. In the 'Image' field, just select 'x-sneakers.jpg' again. 

4. In the 'Text' field enter 'This is a longer description for the 
running shoes'.  

5. Under 'Display By', click 'Text Link'. In the 'Link Text' field 
type 'More Info...'. 

6. Click 'Apply Changes'. 
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This change has created an additional 'extended information' page that 
will be opened in a pop-up window when you click the 'More Info' text 
on your running shoes product in the preview. 

In order to see the effect this change has made, you w ill need to: 

7. Do a page preview by cl icking the  button on the toolbar. 

8. Then browse to your running shoes, which are currently in 
the 'Homeware' section. 

9. When you get there, click the 'More Info...' link. 

 

The main help file includes some information on how to open an 
extended information page in the same browser window, and include a 
cart button in the page. That way, you can use these pages as 'full detail' 
pages for your products, and also allow customers to order from these 
pages. 

More Information - Other Product Settings 
If you want to ask a general question when people buy this product, then 
enter the question within the 'Other Info' field on the 'Prompts' panel. 
You can also add a date-related question here such as 'When would you 
like the flowers delivered?'. 

 

Use the 'Product Layout' field in the 'Layout' panel to try alternative 
layouts for this product. If you want a more compact layout, try the 'No 
Image No Description Laid Out In Single Line' layout. Feel free to 
experiment with the different layouts there to see the effect they have. 
Change it back to 'Use Parent' if you want to put it back to the way it 
was. 

There is more information on choosing layouts in "Choosing A lternative 
Layouts" on page 76. 

It is also possible to import a whole load of products in one go from a 
spreadsheet with an import. This is described in the main help in the 
section called 'Importing'.   
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Sections 
You can use sections to organise your products into separate pages - a 
section becomes a web page in the online store. You can create sections 
within other sections to create a store hierarchy - and Actinic w ill 
automatically create a link from one section to another. 

Exercise - Adding a New Section 
This exercise will add a new section to the store, and show you how to 
place your new 'Running Shoes' product within i t. 

1. Right-click on the 'Clothing' section and select 'New Section'. 

 

Note: If you select 'New Sub-Section', it creates the section within the 
current section. 

2. Enter a name of 'Sportswear' and a description of 'A  great 
range of sports clothes'.  

3. Click 'Apply Changes'. 

 

Your new section has been created in the content tree. The description 
will be used in the l ink to the section, which will appear on the store 
front page (you can view this page by clicking on the green 'Online 
Catalog' icon in the content tree).  

You are now going to drag and drop your 'Running Shoes' product into 
the new 'Sportswear' section. 

4. In the content tree click on the 'Running Shoes' product and 
hold the mouse button down. 

5. Keeping the mouse button held down, drag the mouse 
cursor into the 'Sportswear' section.  
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6. Release the mouse button. The running shoes product should 
now be in the 'Sportswear' section. 

 

Exercise - Optimising A Section 
This section will show you how to use the 'Shopping Mode' feature - 
which controls how products in a section behave when they are added to 
the shopping cart.  

You will also see a few search-engine optimisation features. 

1. Go to your 'Sportswear' section and go to the 'Page Settings' 
panel. 

2. Change the 'Page Name' field to 'sports-clothing.html' (all 
lower case). 

3. In the 'Page Title' field enter 'Sportswear: Sports clothing, 
tracksuits, running shoes'. 

4. Click 'Apply Changes'. 

These two changes will help your page to be more visible to search 
engines. 

The next change will remove the 'Quantity' field from the HTML page. 

5. Under 'Shopping Mode' (on this panel) de-select the 'Use 
Parent Settings' checkbox and select 'Quantity in Shopping 
Cart'. 

6. Click 'Apply Changes'. 

 

Online customers will now enter the quantity of products they require 
once they have added product to the shopping cart. 
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Product Options 
There are many different ways to add options to a product. Here are 
some examples of things you can do in Actinic: 

·  A  simple range of colour options. 

·  A  range of colour options where each colour is individually 
stock monitored. 

·  A  range of size and colour options. 

·  An extra add-on that costs extra. 

·  A  range of options where each choice costs a different 
amount. 

Options in the content tree look like this: 

·  A ttributes -  - These are characteristics of a product that 
can vary such as 'style', 'length', 'size', etc. 

·  Choices -  - These are individual options within an 
attribute. 

·  Components -  - These allow you to create more 
sophisticated options such as an optional extra (that costs 
money) or a range of options where each option is a different 
price. 

You can create options using the 'Product Options' panel of a product. 

Exercise - Creating Simple Choices 
This exercise will allow you to create a range of simple size choices for 
your running shoes. 

1. Click on your running shoes and select the 'Product Options' 
panel. 

 

2. Click the 'Add a New Option...' button to start the 'Add a 
New Options' w izard. 
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3. In the 'Name of Option' field, enter 'Size'. 

4. In the 'Choices for Size' grid, click the '+' button (at the top 
left) six times to create six blank rows. 

 

5. Click in the first row and enter '7'.  

6. In the rows under that enter '8', '9', '10', '11' and '12'. You can 
use the 'down' arrow on your keyboard to move to the next 
row quickly. 

7. When you have entered your choices, click 'Next'.  

8. Just click 'Next>' again tw ice (as you are not setting prices, 
stock levels or layouts) and then click 'Finish' to create your 
options. 

Your new options will be visible in the content tree. You might need to 
click the 'Expand A ll Current Options' button to see all the options. 

 

By default, choices appear as a drop down list in your store. If you 
wanted to change your choices to radio buttons, you can select an 
alternative layout within the 'Layout' panel of the 'Size' attribute. 

Exercise - Choice-Dependent Pricing 
This exercise will add a new option to the running shoes of 'In-soles'. 
When customers purchase the shoes, they will be able to choose whether 
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they want an in-sole or not, and which type they want - w ith each one 
being a different cost. 

1. Go to the 'Product Options' panel of the running goes again, 
and click the 'Add a New Option' button. 

2. Under 'Name of Option' enter 'Type of In-Sole' and then 
enter two choices - 'Basic and Super'. 

 

3. Click 'Next' and in the grid on the next screen, enter a price 
of '5.00' for the 'Super' option. 

 

4. Click 'Next' and in the next screen, change the 'Select Layout 
for Options' drop down list to 'Permutation Radio Button 
List'. 

 

5. Click 'Next' and then click 'Finish' to create the new option. 

 

You now need to do a couple of changes to the 'component' Actinic has 
created in order to make the 'Type of Insole' optional (i.e. the customer 
can choose not to have one. 

6. Look at the options within the 'Running Shoes' product 
within the content tree. You should have two components - 
'Option' and 'Option1'. 

 

7. Click on 'Option1'. 

8. Look at the details of the component, and change to the 
'General' panel if you are not there already. 

9. Change the 'Component Name' from 'Option1' to 'Optional 
In-Sole'. 
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10. Select 'Is Optional' and also select 'Include None in Attribute 
Choice List'. 

 

11. Change to the 'Permutations' panel. 

 

The main grid here is where you can edit prices if required. 

12. Click 'Apply Changes' to confirm your changes. 

  

More Information - Stock Levels 
When you create options for a product, you have the option of entering 
stock levels for your choices. 

 

When you do this, Actinic creates a 'hidden product' for each choice. 

 

These hidden products contain the stock for each option. They are 
associated with each choice within the Permutations panel of the 
component. The associated product is in the 'Product' column in the grid. 

 

So when your customers select a certain choice online, they are 
effectively purchasing a specific hidden product. 
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Brochure Pages 
Brochure pages are optional information pages you can include with 
your store pages such as 'Special Offers', 'Latest News' etc.  

There are two example brochure pages supplied with Actinic - 'Home' 
and 'More Pages'. You will find these at the top of the content tree. In the 
preview, you wil l see a list of the brochure pages in the sidebar. 

 

Brochure pages cannot contain products, but they can contain 
'Fragments' - which are information items on a page. Sections can also 
include fragments. 

Exercise - Creating A Brochure Page 
This w ill create a new 'How To Find Us' page in your store, and include 
an example information item within it. 

1. Right-click on the 'Home' page at the top of the content tree 
and select 'New Brochure Page'. 

2. In the 'Name' field enter 'How To Find Us'. 

3. In the 'Button Image' field click 'Browse' and locate 
'button_brochure_location.gif' in your 'Site1' folder. 

4. In the 'Button Rollover Image' field click 'Browse' and locate 
'button_brochure_location_highlight.gif' in your 'Site1' 
folder. 

 

These images are not used in the default Actinic theme, but they may be 
visible in other themes. 

5. Click 'Apply Changes'. 

This has created a new page in the content tree. 

You are now ready to include a fragment into the page. 

1. Right-click on your new 'How To Find Us' page and select 
'New Fragment'.  

2. In the 'Fragment Title' field enter 'How To Find Us'.  

3. In the 'Text' field enter 'Here is how to find our offices....' 

4. Change to the 'Layout' panel and change the 'Fragment 
Layout' to 'Headline Fragment Layout'. 
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5. Click 'Apply Changes'. 

If you have a suitable image to use for e.g. a map then you can always 
select it in the 'Image' field in the 'General' panel. 

More Information - Links 
If you are creating a fragment that refers to a product or a section in the 
store, you can use the 'Links' panel to create a l ink to that i tem. Then just 
include [LINK] in the 'Text' field, where you want the link to appear.  
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Uploading Your Store 
In order to really see your store in action, you need to upload it to a 
website. This w ill publish your website to the internet, and you w ill be 
able to use the search, shopping cart and checkout functionality, and 
place test orders. 

Exercise - Uploading a Trial Copy of Actinic 
If you are using a trial version of Actinic, which has been pre-configured 
to work with a specific site, it is simple to upload it to the internet. 

1. Press the 'Publish To Web' button ( ) on the 
toolbar (or go to 'Web |  Publish to Web'). 

2. You will be prompted to enter a username and password. 

3. If you do not have a username and password then you will 
need to register for one online. 

·  Click on the 'To Apply For A New Account' link, and 
follow instructions on the website. 

·  Once you have supplied the required information and 
received a username and password, enter the username 
and password into the fields provided in Actinic. 

4. The upload should then continue. 

 

The first time you upload, it w ill take quite a while as it needs to upload 
the entire site. After that, however, Actinic wil l only upload the files that 
have changed. 

One the upload is completed, click the  button on the toolbar (or go to 
'Web |  View Online Website') to view your store online. 

More Information - Uploading Actinic To Your 
Own Website 

The instructions in this section will work for most web sites, but they 
won't work w ith all of them. If you find they don't work for your website 
then you w ill need to contact your web hosting company. 
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When the Actinic store is uploaded to your web site, all the store files 
(with a few specific exceptions) are uploaded to two folders on your 
website: 

·  'CGI' folder (often called 'cgi-bin') where all the script fi les 
will be uploaded to in order to run the online search, 
shopping cart and checkout. These fi les are sometimes 
referred to as 'Perl files'. 

·  An online store folder, which Actinic will create, that 
contains all your store HTML files and images. 

Note: The 'home' brochure page can be uploaded to the directory level 
above the online store folder by selecting the 'Use as Web Site Home 
Page' box on the 'home' brochure page. 

Before you try uploading your store you need to know: 

·  The URL ('http:/ / ') address of your CGI folder. 

·  Where the CGI folder is located on your web site (as it 
appears when you connect via an FTP program).  

You will also need to know: 

·  The URL and the FTP location of the folder on your website 
that you would like Actinic to create the online store folder 
within.  

When you have these pieces of information, you can start the 'Web Site 
Configuration Wizard' by going to 'Web |  Configure Web Site Details'. 

 

 The Web Site Configuration Wizard w ill ask you for your username and 
password to connect to your website, and will ask you to confirm the 
locations, and the http addresses, of the folders mentioned above.  

You can often just accept the defaults to achieve a successful upload. 

When the wizard has finished, you can review the settings at any time by 
going to 'Web |  Network Setup'. 

From now on, simply click the  button on the toolbar to 
upload your store.  
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For more detailed information on uploading, open the main help and go 
to 'Putting Your Store Online'. 
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Running an Online Business 

Business Settings 
'Settings |  Business Settings' is where you can enter details about your 
company and how you do business. 

 

You can also set up how you will take payments and charge postage, 
which are both discussed in later chapters. 

It is essential to communicate clearly with your customers on the site 
about who you are, where you are based, how long it's going to take to 
fulfi l orders etc. This builds trust in your potential customers, and makes 
them feel more comfortable about placing an order with you. It also helps 
set expectations of customers about delivery times etc. 

Actinic's main way of communicating al l this information is via an online 
'Terms and Conditions' page. This is linked to from every page, including 
the checkout, and contains all the information about who you are and 
how you do business. Contact information is also included on the online 
receipt, and all emails and reports generated by Actinic. 
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Exercise - Entering Company Contact Data 
This exercise will show you where to enter your company details into 
Actinic, and also enter information into an online terms and conditions 
page. 

1. Go to 'Settings |  Business Settings' or click the  
button on the toolbar. Make sure you are on the 
'Company/ Contact' panel. 

2. In the 'Name' field, enter your company name. 

3. In the 'Address' and 'Post Code' fields, enter your address. 

 

4. In the 'Contact' area at the bottom, enter your name into the 
'Name' field. 

5. You can delete whatever is in the 'Job Title' field - or change 
it to suit your requirements. 

6. Enter a phone number in the 'Phone Number' field and an 
email address in the 'Email Address' field. You can also enter 
a telephone number into the 'Customer Service Number' 
field at the top. 

7. Enter your website address into the 'Web Site Address' field. 

8. Click 'Apply'. 

Now you have entered some company details, you can enter some terms 
and conditions information. 

9. Change to the 'Terms and Conditions' panel. 

10. In the 'Delivery Schedule' tab, change 'We deliver your order 
right away' to 'Where possible, we will always ship orders 
the same day they are received'. 

 

11. Feel free to make any other changes to the text in the tabs. 

You can now check the results in the preview. 
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12. Go to 'Web |  Preview Store' or click the  button in the 
toolbar. Make sure you are previewing the whole store and 
not just the current page. 

13. Click the 'Terms & Conds' button (or 'Terms' or 'Info' or 
whatever it is called in the theme you are using) to check out 
your changes. 

Exercise - Tax 
In 'Business Settings' you also set up whether you want to enter your 
product prices including tax or excluding tax. 

1. Go to the 'Company/ Contact' panel in 'Business Settings'.  

2. Change the 'Tax 1 Description' field to read 'VAT Number' 
(or equivalent if you charge an alternative type of tax e.g. 
'Sales Tax #'). 

3. In the 'Tax 1 Number' field, enter your company tax 
registration number.  

4. Click 'Apply'. 

Now change to the 'Tax' panel. 

5. On the Tax panel, under 'Product Prices Entered', select 
'Inclusive of Tax'. 

 

This means that you can enter prices for your products including tax, and 
Actinic will separate out the tax in the online shopping cart and in the 
order. 

6. Click 'OK', or if you want to go back to entering prices 
without tax click 'Cancel'. 

To find out more about configuring tax, look at the chapter called 'Setting 
Up Tax', w ithin the 'Business Settings' section in the main help. 

More Information - Advice On Selling 
The most important aspect of selling online is how effectively you 
communicate with your customers - both on the site as they customers 
are browsing, and also after the order has been placed. A missing postal 
address for your company, or unclear information about delivery times 
will lose you more orders than a design element that is slightly out of 
alignment. So take the time to get your terms and conditions right, before 
getting into the more technical aspects of the Actinic store. 
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Taking Payments 
Actinic offers a wide range of options for you to take payment from your 
customers. 

You may choose to use a 'payment service' to process your customer's 
card detai ls. A  'Payment Service Provider' (PSP) is a company that wil l 
take your customer's card details online, and process them there and 
then. You w ill then download the confirmation that tel ls you the 
customer has paid. Actinic is integrated with a large number of PSPs, 
including 'Actinic Payments' - its own payment service. 

If you have an existing business, and already have the abil ity to process 
credit card numbers yourself, then you may just need a way for your 
online customers to send you their card details. If you want to work in 
this way, you will need SSL - a method for sending information securely 
over the internet. If you want, you can purchase your own 'SSL 
certificate' for your site, and Actinic will work w ith it. You might want to 
talk to your web hosting company about this. A lternatively, Actinic (and 
others) offer a 'Shared SSL' service that will allow you to take credit card 
numbers securely for an annual fee w ithout needing your own SSL 
certificate. 

Exercise - Adding a Payment Service 
This exercise will show you how to integrate your store w ith an online 
payment service. In this example, we will be using Actinic Payments. 

1. Go to 'Business Settings |  Payment and Security'. 

2. Click the '+' at the top left of the main grid. 

3. In the new row created select 'Actinic Payments Ecommerce' 
from the drop-down in the 'Payment Method' column. 

 

If you want to integrate with a different payment service, 
select an alternative one from the list. 

4. Edit the 'Web Site Description' field to change how the 
option will be presented to your customers at the web site. 

5. Now click 'Configure Method'.  
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This is where you can enter details about your account with the payment 
service. Click 'Information and Registration' if you want to apply for a 
test account to try it out with. 

If you don't have any settings to enter here yet, just click 'Cancel' and 
remove 'Actinic Payments' from the l ist of payment methods (by right-
clicking on the grid and selecting 'Delete Row'). 

More Information - Capturing Card Details 
Yourself 
If you have the abil ity to process credit card numbers yourself, your bank 
might allow you to receive card detai ls from your customers at your 
online store, and then process them when you download the order. 

If you want to do this, you need to make sure the 'Credit card detai ls 
captured for later processing' payment method is available in the 
'Payment Methods' grid. 

You can then cl ick 'Configure Method' to decide which security method 
you use, and which credit cards you wish to accept. 
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Shipping Charges 
Actinic allows you to charge your customers for shipping their order to 
them. There are two approaches to charging for shipping: 

·  Use a simple rate that is easy for customers to understand. 
You could base this on the kind of products being ordered, 
or the number of items in the order. 

·  Use a more sophisticated calculation system that works out 
more precisely what the order will cost to ship, and passes 
that cost onto the customer. 

However you want to charge shipping, Actinic has a range of tools to 
meet your needs. 

Exercise - Charging Shipping Based on the Type 
of Product Being Shipped 
This exercise will show you how you can set up basic shipping charges 
just for the three clothing products in the example store, which will be 
different to the charges for the other products in your store. 

To start w ith, you are going to create a new 'Shipping Category' called 
'Clothing' and then place your three clothing products within this 
category. 

1. Go to 'Business Settings |  Shipping and Handling' 

2. Change to the 'Categories' tab. 

3. Click the '+' at the top left of the grid to add a new row to the 
grid.  

4. In the new field enter 'Clothing'. 

 

5. Click 'OK' on 'Business Settings' to close it. 

6. Now click on the 'Basic T' product in your tree. 

7. Change to the 'Details' panel. 

8. Change the 'Shipping Category' for this product to 'Clothing'. 

  

9. Click 'Apply changes'. 

10. Repeat this for the other two products in the section. 
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You can now enter some shipping charges for the 'Clothing' products in 
your store. 

1. Go back to 'Business Settings |  Shipping and Handling'.  

2. Change to the 'Zone/ Class Tables' tab. 

3. In the white box to the left, right click on the 'United Kingdom' 
zone and select 'Add Class |  New Class...'.  

 

If you don't have 'United Kingdom' in the box, you could use any of the 
countries you see there. 

4. Give the new class a name of 'Test' and click 'OK'. 

5. With 'Test' selected in the white box, change the 'Basis' drop 
down to 'Category'. A  grid should appear in the 'Zone/ Class 
Tables' tab. 

 

6. In the 'Default' row, enter a 'Fixed Charge' of '£2.00' and a 'Per 
Item Charge' of '£1.00'. 

7. In the 'Clothing' row, enter a 'Fixed Charge' of '£1.00' and a 'Per 
Item Charge' of '£0.50'. 

8. Click 'Apply'. 

Your t-shirts and sweater w ill now incur a different shipping charge to 
the other products in your store. 

Exercise - Calculating Shipping Based on the 
Weight of the Order 
This exercise will show you how to calculate shipping based on the 
weight of products in the order. 

1. Within 'Business Settings |  Shipping and Handling |  
Zone/ Class Tables', click on the 'Test' class you created in the last 
exercise. 

2. Now change the 'Basis' drop down to 'Weight in kg'. 
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3. Click the '+' at the top-left of the grid that has appeared. In the 
new row, enter a weight of '0.25' and a cost of '£2.00'. This means 
that orders that weigh up to 0.25 kg will be charged a cost of 
£2.00. 

4. Add another new row that has a weight of '0.50' and a cost of 
'£3.50'. This means that orders that weigh between 0.26 kg and 
0.50 kg will be charged a cost of £3.50. 

5. Add another new row that has a weight of '1.00' and a weight of 
'£5.00'. 

 

You now need to handle what will happen w ith orders that weigh over 
1.00 kg. 

6. Change the 'Excess' setting to 'H ighest Table Value'. 

This means that anyone with an order that weighs more than 1.00 kg will 
be charged no more than £5.00. 

Finally you are ready to enter some weights in for your products. This is 
done in the 'Weight in kg' field at the bottom left of the product 'Details' 
panel.  

Exercise - Setting Up Free Shipping for Specific 
Products 
It is simple to give certain products free shipping. 

1. Go to the 'Details' panel of a product that you want to have free 
shipping. 

2. Select the 'Exclude from Shipping Band Calculation' checkbox. 

 

3. Click 'Apply changes'. 

This product will now be exempted from any shipping charges. 

You can also enter a value in the 'Shipping Supplement' field here if you 
want a product to always cost a specific amount to ship. 

More Information - Shipping By Volume 
Actinic supports calculating shipping charges based on the 
dimensions/ volume of the order. 
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You can enter a 'volume' value in the 'Volumetric Weight' field w ithin the 
'Details' panel of a product. Then you can set the calculation basis for a 
particular shipping class to 'A lternative Weight' using the 'Basis' drop-
down within the 'Zone/ Class Tables' drop down list. Then fill in a table 
of values in the same way as for weight - as described above. 
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Marketing and Promotion 

Best Sellers and New Products 
'Best Seller Lists' and 'New Products Lists' are list of products that can 
appear on every page (or just on specific pages) to promote certain 
products to your customers. 

Best sellers lists work out the best selling products from the orders that 
have been received, and display them as a list in the store. The best 
selling items in your store are the ones that most people w ill come to 
your site to buy, so by displaying them prominently in your store you 
will help customers find them more quickly, which will hopefully turn 
into more new orders. 

New products lists are made up of the newest items that have been 
added to the store. It is important to keep displaying your newest 
product lines as this keeps your store content current and up to date and 
hopefully gives customers a reason to keep coming back to your store.  

By default in the example Actinic store there is a new products list in the 
sidebar of every page, and also on the brochure home page.  

Exercise - Adding A Best Sellers List 
This exercise will add a 'Best Sellers' l ist to your store pages. 

1. Go to 'Marketing |  Best Sellers'. 

2. In the 'Include Sales from last' field, enter '999'. 

3. Click 'Generate Now'. 
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This w ill search through the demo orders that are in Actinic and work 
out the best sell ing items from that. 

4. Change the 'Include sales from last' field back to '30' and 
click 'OK'. 

5. Now click 'OK' and look at your site in the 'Page Preview ' 
panel. You should see a best seller list in the sidebar of every 
page, and also one on the home page. 

 

6. Now go to 'Marketing |  New Product Listing'. 

7. Click 'Generate Now'. The running shoes should be added to 
the grid. 

8. Click 'OK' and you should see the running shoes in the 'New 
Products' l ist on the sidebar of each page. 
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Exercise - Changing Where The Lists Appear 
This exercise will allow you to control where the best sellers and new 
products lists appear in the store. 

1. Go to 'Settings |  Site Options' and change to the 'Layout' 
panel. 

2. Find the 'Best Sellers List' sub-heading at the bottom of the 
grid. 

3. Change the 'Location For Best Sellers List' setting to 'Home 
Page Only'. 

4. Now under 'New Products List' change the 'Location for 
New Products List' setting to 'Sidebar Only'. 

 

5. Click 'OK'. 

You should now have best sellers list appearing on the brochure home 
page and the new products listing appearing in the sidebar of every 
page. 

Note: If you try and change the 'New Products List Layout (For Sidebars)' 
or the 'Best Sellers List Layout (For Sidebars)' it doesn't change anything 
in the default theme, but it w ill have an effect in other themes. 

More Information - Customising the Lists 
If you go to the grid at the bottom of 'Marketing |  Best Sellers' or 
'Marketing |  New Products Listing' you can click on any item in the list 
and use the drop-down list to manually change it to a different item. 

You can also click the 'Lock' checkbox to fix that product in the l ist and 
let all the other products auto-generate around it. 

 

If there is a certain product that you don't want to appear in the 
marketing lists, de-select the appropriate checkbox within the 'Marketing' 
panel of the product.  
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Related Item Lists and Also Bought Lists 
As well as the best seller lists and the new products lists, it is also 
possible to place some marketing lists underneath the products in the 
store. There are two types of these lists: 

·  Related Product l i sts - where you can set up a list products 
that are all related in some way to a certain product. 

·  A lso Bought l i sts - (Actinic Business/ Designer only) - these 
are automatically worked out by Actinic. Actinic can take a 
product in your store, then look at all the orders that include 
that product, and then look at what else the customers order. 
These then become a 'customers who bought this also 
bought...' list underneath the product. 

As well as appearing underneath products in the store, these lists can 
also appear on the shopping cart page in the online store. That way, 
customers can see some products that are related to the products that 
they already have in their shopping cart. 

Exercise - Creating a Related Products List 
This exercise will include a related products list for the 'Basic T' product 
in your store. 

1. Go to 'Marketing |  Related Products'. 

2. Select 'Enabled'. 

3. Click 'OK'. 

4. Now go to the 'Basic T' product (within the 'Clothing' 
section). 

5. Go to the 'Marketing' panel and click the '+' at the top left of 
the 'Product Related Products' l ist. 

6. In the row created, choose 'Premium T' from the drop-down 
list. 

This is an example of how you might use the related products list to 
create an upsell from one product to another. 

7. Now click the '+' and this time select 'Pair of Sandals' from 
the list. 

 

8. Click 'Apply Changes' and check out your changes in the 
preview. 

Exercise - Also Bought Lists 
Actinic Business/Designer only 



Getting Started Guide Marketing and Promotion  ····   43 

This exercise will generate 'customers who bought this also bought...' l ists 
into your store, and show you how to change the layout of them. 

1. Go to 'Marketing |  A lso Bought...' 

2. Select 'Enabled'.  

3. Change the 'Include Sales from last' field to '999' and then 
select 'Generate Now'. 

 

This w ill generate a list for nearly every product in the default store. 

4. Change 'Include Sales from last' back to '30' and click 'OK'. 

5. Go back to the 'Marketing' panel for the 'Basic T' product. 

You should see that some products have been automatically added to the 
list. These products will appear in a fairly standard numbered list by 
default, but there is an alternative layout option. 

6. Go to 'Settings |  Site Options |  Layout'. 

7. Under the 'Product' sub-heading, find the 'Product A lso 
Bought Item Layout' setting. 

 

8. Change this setting to 'Mini A lso Bought Item' and click 'OK'. 

This should include an image, price and description into the also bought 
list for the 'Basic T'. 

 

The related items list also has an equivalent layout option. 

More Information - Lists in the Shopping Cart 
Once you enable either related item lists or also bought lists you w ill see 
a list appearing in the online shopping cart underneath the grid of 
products. These lists show the related products and also bought products 
for the product that is currently in the shopping cart. If there is more than 
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one product in the shopping cart, then Actinic wil l merge all the related 
products and also bought products into a single l ist. 
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Mailing Lists 
Actinic gives you the abil ity to easily extract your customers' contact 
details out of Actinic. This information can then be imported into 
emailing programs like Microsoft Outlook or GroupMail in order for you 
to mail your customers w ith promotional material. 

This feature can be found at 'Marketing |  Mailing Lists'.  

 

A ll versions of Actinic allow you to filter your customers' contact details 
based on when they placed orders, and what the status of the order is. 
Actinic Business/ Designer customers can go further and filter the list 
based on what products were ordered, where the customer is located and 
how large the order was. With Actinic Business/ Designer, you can also 
print mailing list information onto labels and envelopes. 

Exercise - Creating a Mailing List 
This exercise will show you how to build a mailing list based on the three 
example orders that are in the 'Orders' tab in Actinic. 

1. Go to 'Marketing |  Mailing Lists'. 

 

2. Under 'Order Status', de-select 'Completed' and select 'Any'. 
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3. In the 'From' field, make sure the date is somewhere before 
May 25th 2006 - as that is when the three example orders 
were created. 

4. Make sure that 'Order Payment Status' is set to 'Any'. 

5. Click the 'Preview List' button. 

 

This shows you the three sets of customer data that are ready to export. 

6. In the 'Format' field, select 'Standard Format'. 

7. Click the '...' button next to the 'Filename' field. 

8. Browse to your computer's desktop and enter 'export.csv' in 
the 'Fi le name' field. Click 'Save'. 

9. Back on the 'Mail ing Lists' w indow, click the 'Export List' 
button.  

Actinic automatically removes any duplicate records, based on the email 
address supplied with the order. 

Exercise - Advanced Filtering 
Actinic Business/Designer only 

This exercise will show you how to filter the mailing list based on 
whether customers have ordered the 'Knitted Sweater'. 

1. Go to 'Marketing |  Mailing Lists' and go to the 'Select 
Products' tab. 

2. Click 'Get Products'. 

3. In the tree, click the '+' next to 'Online Catalogue'. Then click 
the '+' next to 'Clothing'. 

4. Select the 'Knitted Sweater' checkbox. 

 

5. Now go back to the 'Main' tab and make sure that the 'From' 
field is set to sometime before May 25th 2006. 

6. Finally, press the 'Preview l ist' button to update the list. It 
should only contain 'Jack Smith'. 
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Filtering can also be done on location (in the 'Location Lookup' tab) and 
order size (in the 'Order Details' tab). 
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Order Level Discounts 
Order-level discounts are available in all versions of Actinic, including 
Actinic Catalog. They allow you to create discounts in the store that are 
triggered by how much the customer has spent online. For example, you 
can use this to create a discount that says "10% off all orders" or "£10 off 
all orders over £75".  

Exercise - Creating a Discount Based on Order 
Value 
This exercise will create a 'weekend sale' where all orders have 10% off 
w ithin a set time period. 

1. Go to the 'Marketing' menu and then select 'Discounts and 
Surcharges Settings...'. 

2. Go to the 'Order Level ' tab (if you are not on it already). 

3. Click the 'New ' button at the right and enter a name for your 
discount of 'Weekend Sale'. 

 

4. Change the 'Based On' field to 'Cart Value Including Default 
Tax'. 

5. Change 'Type' to 'Percentage'. 

6. In the 'Triggers' grid click the '+' at the top left and enter a 
value of '10' in the 'Percentage' field. 

7. Click 'Apply'. 

 

This w ill put a discount on your store right away, so before you upload 
and test this, you are going to restrict the discount to only being for this 
coming weekend. 
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8. Change to the 'Restrictions' tab (within the 'Order Level' tab). 

9. In the 'From' field select the upcoming Saturday. 

10. In the 'To' field select the upcoming Sunday. 

 

11. Click 'OK' 

There will now be a 10% discount on al l orders placed at your store for 
the coming weekend. 

Note: you may want to remove this discount if you are about to put your 
store live! 

More Information - Restricting Discounts 
In the exercise above you restricted a discount to a date range. You don't 
have to set both the 'For' and 'To' fields - you can set one or the other if 
you want to start a discount now and end it on a certain date, or start a 
discount on a certain date and let it run indefinitely. 

Additionally, if you are using Actinic Business/ Designer, you w ill see in 
the 'Restrictions' tab there is also a 'Restricted to Customer Group' grid. If 
you wanted a discount only for your retail customers or for specific 
customer groups you can use the grid to set it up. 

Customer groups are discussed in a later chapter. 
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Advanced Discounting 
Actinic Business/Designer Only 

As well as creating discounts based on order value, Actinic Business and 
Actinic Designer allow you to create discounts that are based on the 
items that are in the shopping cart. This allows you to set up discounts 
such as '3 for the price of 2' and 'Buy any three books for 5.00'. 

There is an example '3 for the price of 2' discount already set up in the 
'Cart Contents' tab in 'Marketing |  Discounts and Surcharges Settings'. 

A lso, you have the option to activate any of the discounts by customers 
entering a specific coupon code online. 

Exercise - Buy Both T-Shirts for 10.00 
This exercise will create a new 'Fixed Price' discount for the two t-shirt 
products that are in the default database. The first thing you need to do is 
tel l Actinic that the two t-shirts are related to each other. This is done by 
putting them both into a 'Product Group'. 

1. Go to the 'Marketing' menu and select 'Product Groups'. 

2. Click 'New' and enter a name of 'T-Shirts'. 

3. Select the 'Basic T' product from the right-hand list and use 
the '<' button to move it to the 'Members' list. 

4. Do the same for the 'Premium T'. 

 

5. Click the 'Discounts' button and click 'OK' on the message 
that appears. 

You should now be on the 'Cart Contents' tab w ithin 'Discounts and 
Surcharges Settings'. 

6. Click 'New' and enter a discount name of 'T-Shirt Offer'. 

7. Change 'Based On' to 'Quantity'. 

8. In the 'Trigger' field, enter '2'. 
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9. Change 'Product Group' to 'T-Shirts'. 

10. Change 'Reward Type' to 'Fixed Price'. 

11. In the 'Reward Amount' field enter '10.00'. 

 

12. Click 'Apply'. 

13. Change to the 'Presentation' tab. 

14. Enter the following text: 'Buy both t-shirts together for only 
10.00'. 

15. Click 'OK'. 

The 'Buy both t-shirts together...' message w ill appear underneath the 
descriptions of both t-shirt products in the preview, and will also appear 
in the shopping cart.  

Exercise - Coupons 
This exercise will set up a discount that is only triggered when customers 
enter a coupon code online. 

1. Go to the 'Order Level ' tab within 'M arketing |  Discounts 
and Surcharges Settings'. 

2. H ighlight the 'Weekend Sale' discount you created in the last 
chapter. 

If you don't have this discount set up, then highlight the 'Order 
Adjustment Example' discount (which is in the default database) and 
select 'Enabled'. 

3. Select the 'Requires Coupon Code' box. 

4. Enter a coupon code of '12345'. 

5. Click 'Apply'. 

6. Now change to the 'Miscellaneous' tab. 

7. Under 'Coupon Codes' select 'Store Pages'. 

8. Click 'OK' 

 

This should insert a coupon entry field into the sidebar of your store 
design.  
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More Information - Offering Products as 
Rewards 
One of the 'Reward Type' options you have in the 'Cart Contents' tab of 
'Discounts and Surcharges Settings' is 'Money off extra product' and '% 
off extra product'. These allow you to offer customers free/ cheaper 
product as part of a promotion. 

The 'extra product' in question is any product from a specific product 
group that you have set up in Actinic. If you want just to offer a specific 
single product then you wil l need to create a product group that just 
contains that one single product. 
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Day to Day Administration 

Retrieving Orders 
To retrieve any orders placed at the store, click the 'Retrieve Orders' 
button on the toolbar ( ), or go to 'Operations |  Retrieve 
Orders'. Actinic will connect to your store and see if there are any orders 
on the site waiting to be retrieved. It then downloads them and lists the 
orders within the 'Orders' tab. You can view the details of an order by 
double-clicking on it. 

Some people check for new orders throughout the day. If you are not 
expecting that many orders to be placed at your store, you can just check 
your email inbox for 'New Catalog Order Received' notification emails. 
This email is sent just after the first order is placed after the most recent 
order download. You will then know there is at least one order to 
download. 

Note: You must select the 'Send me an Email When I Have an Order to 
Download' checkbox in 'Business Settings |  Ordering' to have this email 
sent to you. 

Exercise - Downloading and Viewing Orders 
This exercise will show you how to download and view order details 
with Actinic. You need to have placed some test orders on the site in 
order to have anything to download.  

1. Once you have placed one or more test orders at your Actinic 
store, sw itch to the 'Orders' tab. 

2. Click the 'Retrieve Orders' button ( ) on the 
toolbar. 

3. Your order should then be listed in the list on the 'Orders' 
tab. 

 

Note: There are three demonstration orders already in Actinic. 
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4. Double click on your new order to open it. 

 

5. The 'Customer' tab shows you the name and address 
information supplied with the order. 

6. Change to the 'Line Items' tab. This shows you the items that 
have been ordered. 

7. Change to the 'Progress and Payments' tab. This shows you 
the payment information entered at the store. 

8. Now click the 'OK' button to close the order. 

In the next chapter you will  see how to process an order. 

Exercise - Creating a Packing List 
When you receive new orders, you can print a 'packing list' for each 
order, which can be used when making up the order, and also can be 
used as a delivery note on the front of the package sent. This exercise w ill 
show you how to print packing lists. 

1. Go to 'Operations |  Report Selection'. 

2. Change to the 'Order Processing' tab. 

 

3. Select 'Outstanding Packing Lists'. 
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If you haven't placed any test orders, you might get a message box 
popping up at this point telling you that there no outstanding reports to 
be printed. You can sti ll see the report, however, by right-clicking on an 
order and selecting 'Reprint Standard Packing List Report'. 

4. Click 'Preview'. 

This w ill lay out the order information within a packing list report. 

 

More Information - Assurances 
Orders are encrypted to two levels on the site. Any credit card 
information is encrypted with a 1024-bit encryption key - which you can 
view by going to 'Housekeeping |  Security'. The name and address 
information is then encrypted as well, but with a lighter level of 
encryption as that information is less critical. 

Orders are stored as files on the website w ith an extension of *.ord. Once 
the order is fully downloaded into Actinic, Actinic wil l send up a 
command to the web site to delete the order files on the site. This only 
happens once Actinic is sure the order has been safely received. 
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Processing An Order 
There is a set of order processing techniques built into Actinic. Some are 
optional, and some are required - i.e. Actinic will not consider an order as 
being 'complete' until you carry them out. The required order processing 
steps are: 

·  The lines of the order must all be marked as 'shipped' or 
'cancelled'. This is shown below. 

·  A ll payments for the order must be marked as being 
'received'. This is also shown below. If you are using a PSP 
(Payment Service Provider) the payment will be taken online 
and so the payments will be marked as received before the 
orders are downloaded into Actinic. 

·  An invoice must be printed for the order. 

A lternatively if you don't want to process orders within Actinic then you 
can select the 'Bypass Catalog Order Processing' option in 'Business 
Settings |  Order Processing'. 

 

This w ill mark the order lines as shipped and the payments as received 
as soon as the orders are downloaded. You can then do one of the 
following actions: 

·  Print a 'Data Entry' report. This is a single piece of paper 
containing every piece of information about an order. To 
enable this feature, you need to select 'Enable Data Entry 
Reports' in 'Business Settings |  Order Processing'. To print a 
data entry report, select 'Outstanding Data Entry Reports' in 
the 'Order Processing' tab of the 'Operations |  Report 
Selection' w indow.  

·  Export orders. This exports order information as a set of csv 
spreadsheet files for importing into another application. This 
is typically done in conjunction with 'Actinic Link' - Actinic's 
accounts integration package (Actinic Business/ Designer 
only). To enable exports, select 'Enable Export to Files' in 
'Business Settings |  Order Processing'. To carry out an 
export, go to 'Operations |  Outstanding Exports'. 

Exercise - Processing an Order 
This exercise will show you how to use Actinic's in-built tools to 
complete a new order. This exercise is based around order number 
'DEMO0000000001' in the example Actinic database, but you could easily 
carry out these steps w ith any order. 

1. Change to the 'Orders' tab (if you are not there already). 

2. Double-click on order number 'DEMO0000000001' in the list. 

3. Change to the 'Line Items' tab. 

4. Highlight 'Great Expectations' and click the 'Ship' button. 
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If the 'Ship' button is not available, it might be because you have selected 
'Bypass Catalog Order Processing' in 'Business Settings |  Order 
Processing'. 

5. H ighlight 'Pair of Casual Shoes' and click the 'Ship' button. 

6. Highlight 'Teapot' and click the 'Ship' button. 

Obviously if you have different order contents, then ship whatever order 
lines are in the tab. 

7. Click the 'Mail' button. This will generate an 'Order Shipped' 
email ready to be sent to the customer. 

 

8. Click 'Done'. 

You can view the email in the 'Mail' tab of the order. And send it by 
going to 'Operations |  Send Emails'. 

9. Change to the 'Progress and Payments' tab, and click 'OK' on 
the warning message that appears (you might want to select 
the 'Don't show this message again' box).  

10. On the 'Progress and Payments' tab you should see the 
demonstration credit card details. Click the 'View Payments' 
button. 

11. Click 'New Entry' and then click 'OK'. 
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This has made an entry in the payment history of the order saying that 
the credit card payment has been received. You would normally only do 
this once you have put the credit card information through a credit card 
terminal. 

12. Click 'OK' to close the order. 

13. Go to 'Operations |  Report Selection' and make sure you are 
on the 'Order Processing' tab. 

14. Select 'Outstanding Invoices' and click 'Print'.  

15. This w ill print the invoice to your printer. 

The order should now have disappeared from the 'Orders' tab. You will 
find it by going to the 'Completed' tab (change tabs at the bottom of the 
window). The order is now marked as completed. 

Exercise - One-Click Order Processing 
Rather than doing each step of the above exercise, it is possible to pre-
configure the things you want Actinic to do to each order, and then 
simply 'Complete' the orders with a single click. This is described below. 

1. Go to 'Business Settings |  Order Processing'. 

2. Select 'Enable One-Click Order Completion' (if it is not 
selected already). 

3. Select 'Print Packing List'. 

4. Select 'M ark Packing List Printed'. 
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5. Click 'OK'. 

6. Now right-click on any order in the 'Pending' tab and select 
'Complete Order'. Or highlight an order and click the 
'Complete' button.  

 

The order should move to the 'Completed' tab. 

More Information - Full Order Details 
All the tabs within an order are described below: 

·  Customer - This is where you can view and edit the 
customer contact information. 

·  Line I tems - Use this tab to ship items, and cancel them. You 
can also click the 'Add New Item' button to add a new 
product to the order.  

·  Shipping and Handl ing - You would only really use this if 
you want to change the selected shipping method after 
receiving the order. Change the shipping class in the 'Class' 
field at the bottom right, and then click 'Update Order 
Shipping'. You can also manually enter a shipping charge 
into the 'Calculated' field. 

·  Taxes - View the tax charges on the order.  

·  Totals - For reviewing any changes you have made to the 
order  

·  Progress and Payments - Where you can view the order 
status and enter/ edit payment information. 

·  M isc. - This is where you can check any supplementary 
information provided w ith the order such as purchase order 
number, or answers to the 'General Information' questions in 
the checkout. 

·  M ai l  - View the emails generated regarding this order. You 
can also send any pending emails, and generate new ones. 
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·  Journal  - For making notes about the order. 
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Monitoring Stock 
Actinic includes a 'stock monitoring' feature that helps you keep track of 
the stock level of the products in your store. The stock level of a product 
is reduced when an order for that product is downloaded into Actinic.  

You can enter stock levels for products by going to the 'Stock' panel of a 
product and fil ling in the 'Estimated Stock In Hand' field. You will also 
need to make sure the 'Stock Monitoring' checkbox is enabled. 

 

You can also get an overview of the stock levels of all the products in 
your store by going to 'Operations |  Stock Levels' or by clicking the  
icon on the toolbar. This allows you to quickly add/ review stock levels in 
Actinic across a number of products. 

 

There are two stock warning levels for Actinic: 

·  Warn I f  Below - if the stock level of a product falls below 
this level, you will receive a warning when you download 
orders. 

·  Suspend I f  Below - if the stock level of a product falls below 
this level then the add to cart button will be replaced w ith an 
'OUT OF STOCK' message. 

You can set default values for these two stock warning levels in 'Business 
Settings |  Options'. 

 

By default, none of the products in the example store are stock 
monitored. 
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Exercise - Stock Monitoring 
This w ill simulate what happens when a product goes out of stock. 

1. Go to your 'Running Shoes' product you created earlier. 

If you don't have this product, you can use any product. 

2. Switch to the 'Stock' panel. 

3. Set the stock level at '20'. 

4. Click 'Apply changes'. 

This product is now stock monitored. If you place a test order for this 
product the stock value will go down. 

5. Now change the stock level to '1' and click 'Apply Changes'.  

6. You should find that the add to cart button has been replaced 
with an 'Out Of Stock' message. 

 

7. Now go to 'Operations |  Stock Levels'.  

8. Change the 'Select Product Type' drop down to 'Ordering 
Suspended' to see the product you have just put out of stock. 

You would now need to upload the store in order to see the product 
marked as being out of stock online. 

More Information - Stock Reports 
There are a few reports available to help you monitor stock levels in your 
store. If you go to 'Operations |  Report Selection' there is a 'Catalog' tab 
that features four 'Stock Level ' reports. You can print these to help you 
monitor the stock levels in your store. 
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Entering New Orders 
As well as receiving orders from your online store, Actinic also al lows 
you to enter orders straight into the program. This allows you to also 
take orders over the phone or via fax, and keep all the order information 
in one place. 

Exercise - Adding a New Order Into Actinic 
If you are using Actinic Business (or Actinic Business Plus) then you can 
enter new orders into Actinic using the 'New Order' tab. 

 

To enter new orders into Actinic using the 'New Order' tab, you need to 
do the following: 

1. Click the 'Search' button (in the 'Product Entry' box) to select 
a product to add to the order. 

 

If you know the reference of the product you want to add, you can just 
type it in the 'Ref' field and click 'Show '. 

2. The product details wil l show up in the 'Selected Product' 
area. You can select options and quantities and then click 
'Update Cart'. 

3. Then all you need to do is enter the name and address 
information into the fields provided and select a shipping 
method. 

4. Once you've confirmed the cost of the order with the 
customer (assuming you are taking this order over the 
telephone) you can take the customers payment details and 
then click the 'Confirm' button to add the order to the order 
list in Actinic. 

 

If you are using Actinic Catalog, you won't have the 'New Order' tab so 
you will need to click the 'New Order' button on the 'Orders' tab to add a 
new order to Actinic. 

 

To add a new order into Actinic using the 'New Order' w izard: 

1. Go to the 'Orders' tab and go to 'Operations |  New Order' (or 
click the 'New Order' button at the bottom of the tab). 

2. On the first screen select 'Shopped Before'. This w ill save you 
a lot of typing later on. 
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3. Click the 'Search' button and then click the 'Search' button on 
the new window. This should give you a list of all the orders 
currently in Actinic. 

4. Select an order and click 'Select'. 

 

5. Click 'Next >' to move to the next screen. 

6. Review the contact information and then click 'Next >'. 

7. This screen is where you add items to the order. Click 'New'. 

8. From the 'Select Product' drop down list select 'Set of 
Glasses'. 

9. In the 'Components/ Attributes' w indow select the '8 Glasses' 
option. 

 

10. Click 'OK' and then click 'Next >'. 

11. This screen is where you can select the shipping method and 
enter payment information. Make sure 'Payment Method' is 
set to 'Credit Card' and select 'Type' of 'Visa'. 

12. For the 'Number' enter '1111222233334444'. 

13. Select a valid 'Expiration Date' and click 'Next >'. 

14. Click 'Confirm' to complete the new order. 

Your new order should now be added to the list of orders in the 
'Pending' tab. 
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Exercise - Editing An Existing Order 
It is possible to edit an order to add new items. This exercise will show 
you how. 

1. Double-click on an order in the 'Orders' tab. 

2. Change to the 'Line Items' tab. 

3. Click the 'Add New Item' button. 

 

4. Click 'New' and add the 'Far From the Madding Crowd' 
product to the order. Click 'OK'. 

5. Click 'Next >' then click 'Next >' again and then click 
'Confirm' to complete the addition. 

Your new book should now be visible within the 'Line Items' tab. 

More Information - Settings in Business Settings 
If you go to the 'Order Processing' panel within 'Business Settings' you 
will see there are few settings here under the heading of 'Offline Order 
Processing'. 

 

Select 'A llow Unit Price Override' if you want to be able to change the 
price of items while you create new orders. 

You can also choose a different prefix for the offline order numbers in the 
'Order Number Prefix' field. 
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Regular Customers 
Using Actinic, you can set up customer accounts for your regular 
customers. This allows customers to log into the store with a username 
and password, and have their name and address information preset in 
the checkout. 

If you are using Actinic Business/ Designer you can go further and group 
your customers into 'Customer Groups'. You can then assign discounts to 
these customer groups and also hide products from certain groups of 
customers. 

Exercise - Creating A Customer Account 
This exercise will show you how to create a basic customer account. 

1. Go to 'Operations |  Customer Accounts' or click the  icon 
on the toolbar. 

2. Click 'New Customer'. 

3. In the 'Name' field enter 'Test Account'. 

4. Click the 'Copy Details From Order Contact' button. This 
shows you all the order contact information already in 
Actinic. 

5. Double-click on one of the names in the list. This will 
populate the rest of the fields here - and saves some typing. 

 

6. Change to the 'Addresses' tab. This has been pre-populated 
with the order information brought in by the previous step. 

7. Change to the 'Buyers' tab and click 'New'. 

A 'Buyer' is a customer who will actually log into this account w ith a 
username and password. 

8. Change the 'Login', 'Password' and 'Confirm' fields all  to be 
'a'. This is so you can log into the store quickly to test this. 
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9. Click 'OK'. 

Your new account has now been created. To test this, upload the store 
and click the 'Login' l ink. Then enter a username and password of 'a' to 
log into the account. Add something to your cart and checkout to see the 
preset address information. 

 

Exercise - Creating A Customer Group 
Actinic Business/Designer Only 

You will now create a 'Trade' customer group, who wil l receive a 20% 
discount when they log in.  

1. Go to 'Marketing |  Customer Groups' or click the  button 
in the toolbar. 

2. Click 'New' and enter a name of 'Trade'. 

3. H ighlight your 'Test Account' account and use the '<' button 
to move it to the left 'Associated Accounts' column. 
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4. Click the 'Customer Pricing' button, and click 'OK' on the 
window that appears. 

5. Highlight 'Trade' in the list and select 'Multiply By'. 

6. In the field enter '0.8' and cl ick 'OK'. This w ill give a 20% 
discount. 

 

Now upload the store and log in to test the discount for 'Trade' 
customers. You should see both a 'Retail Price' and a 'Your Price' 
appearing in the store. 

More Information - Sophisticated Buyer Options 
Go back to the 'Test Account' account in Actinic and look at the 'Buyers' 
tab. There are quite a few useful options here: 

·  Select 'H ide Retail Prices' if you only ever want this buyer to 
see a single price (rather than 'Your Price' and 'Retail Price'). 

·  Select 'A l low User to Select or Enter a New Address' if you 
want to allow your customers to enter their own new 
addresses into the store, as well as using a saved address 
online. 

·  You can enter a 'M aximum Order Value' for this buyer if you 
want to limit the amount they can spend on an order. 
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Designing Your Store 

Please note that the following features are not available in 'Client' 
versions of Actinic. 

Choosing A Theme 
A theme is a quick way to give your store a new look and feel. It is worth 
experimenting with the themes that are available so you can find one you 
like - and then use it as a starting point for any further changes. 

Exercise - Changing Theme and Colour Scheme 
This exercise will just use simple settings to change the look and feel of 
your store. 

1. Go to 'Design |  Themes'. 

2. In the 'Themes' list, change it to 'Corporation'. 

 

3. In the 'Color' list, select 'The Blues'. 

4. Click 'OK'. 
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This has now applied a new look and feel to your store, but you can 
change each individual element at a much more granular level. 

For example you can tweak the colours used in the design by going to 
'Design |  Themes' and clicking the 'Advanced Themes Configuration' 
button. Then change to the 'Color Schemes' tab. 

 

You can tweak the colours and then save your colours as a new colour 
scheme. 

More Information - Outer Layouts 
When you change themes in Actinic, as well as copying in new logo 
images and background images, Actinic also changes the 'outer layout' 
for the store. The outer layout (also known as the 'overall layout') is a big 
piece of HTML code that controls the appearance of the header area of 
the design, the sidebars and also the footers. In other words, it lays out 
the elements that do not change when you browse from page to page.  
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You can see the outer layout that Actinic is currently using by going to 
'Settings |  Site Options' and looking at the top of the 'Layout' panel: 

 

The important one here is the 'Overall Page Layout' setting, as that is the 
default one for your section pages. You'll also notice you can have 
different overall layouts for your brochure pages, shopping cart page, 
checkout pages etc. if you really want to. 
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Adding Custom Fields 
Actinic allows you to create any number of custom settings for the items 
in your content tree. Examples of this include an 'Artist' field for CDs, a 
'Starring' field for DVDs, or an 'Author' field for books. These custom 
settings are referred to w ithin Actinic as 'User-Definable Variables', and 
they appear within grids like this: 

 

You can include these custom values into your store designs by inserting 
the variable into the layouts, as discussed in "Help With Design" on page 
81. 

Exercise - Creating a New Variable 
1. To create a new variable, go to 'Design |  Library' (or click the 

 button) and then change to the 'Variables' tab. 

 

2. Right-click on 'Product' in the tree and select 'New Variable'. 
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3. In the 'Name' field, enter 'A uthor'. 

4. In the 'Description' field enter 'New field for the author of the 
books'. 

5. In the 'Prompt' field enter 'Enter Author Name'. 

6. Under 'Place Of Setting' select 'Product'. 

This means that the new field will appear for your products. 

7. De-select 'A llow <Use Parent> as an Option'. 
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8. Click 'OK' and the 'OK' again to close the library.  

You can now change to the Content tab in Actinic and enter the author 
value in for the three books. You will find the new field within the 
'Properties' panel. 

 

Later on in this guide, you'l l see how to insert these values into the 
design. 
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Choosing Alternative Layouts 
It is possible to select different layouts for every single item you see in 
the content tree. This is done by going to the 'Layout' panel of the item in 
question, and selecting an alternative layout. 

Very often a setting w ill have the words 'Use Parent' in it. 

 

'Use Parent' simply means that the value for this setting is set somewhere 
'higher' up the Actinic structure. If you click on a setting it w ill usually 
tel l you where the value has been set in the area underneath the grid of 
settings. 

 

Note: When it says the value is coming from the 'Variable Definition' it 
just means that the 'Top Level Value' for that variable is set in the library. 

Exercise - Changing Layouts 
This exercise will show you a selection of changes you can make within 
Actinic. To begin with, you will change the way your products appear: 

1. Go to 'Settings |  Site Options' and change to the 'Layout' 
panel. 

 

2. Locate the 'Product' heading, and w ithin that, find the 
'Product Layout' setting. 

3. Change it to 'Standard With Image On Left'. 
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4. Now locate the 'Column Count For Products' setting and 
change it from 'Use Parent (=1)' to '2'. 

 

5. Finally, locate the 'Price Layout' setting and change it to 
'Standard Tax Inclusive Price'. 

6. Click 'OK' and then look at one of your sections to see the 
change. 

 

As well as setting default values for the entire store in 'Site Options', you 
can override settings at the section level and at the product level. 

1. In the content tree, change to the 'Computers' section. 

2. Go to the 'Layout' panel of this section. 

3. Click on the 'Column Count For Products' field. It says 'Use 
Parent (=2)' Notice at the bottom of the panel it is telling you 
that the value has been set in 'Settings |  Site Options'.  

 

4. Change the 'Column Count For Products' from 'Use Parent 
(=2)' to '1'. 

5. Change the 'Product Layout' to 'Standard With Image On 
Right'. 

6. Click 'Apply changes' to see the difference in the preview. 

 

It's possible to change the layout and column count for many different 
items in the store, such as attributes: 

1. Select your 'Running Shoes' product. 

2. Select the 'Size' attribute (w ithin the 'Option' component). 
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3. View the attribute's details and change to the 'Layout' panel. 

4. Change the 'A ttribute Layout' to 'Standard Radio Button 
Attribute'. 

5. Change the 'Column Count For Radio Buttons' from 'Use 
Parent (=1)' to '6'. 

6. Click 'Apply changes' and check the preview. Your radio 
buttons should now be in one line. 

 

 

More Information - Layout Selectors 
The layout selection drop-down lists in Actinic are all controlled by 
things called 'Layout Selectors'. It is possible to edit the layout selectors in 
Actinic to change the order of layouts that are offered in the drop-down 
list, remove layouts and even add your own custom layouts. 

There is more information on this in the next chapter - "Inserting 
Layouts" on page 88. 
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The Design Tab 
The 'Design' tab is used to change the look and feel of specific elements of 
your page design. 

 

It has two main areas: 

·  Interactive Preview -  - Click on anything in the 
preview and a dotted line will appear around it. If a piece of 
text is selected, you will be able to change the appearance of 
it w ith the formatting controls in the toolbar above the 
interactive preview (e.g. bold, italic, colour etc.). 

 
A lso, the HTML that lays out the part of the page you have 
selected wil l appear in the 'Layout Code' panel. 

·  Layout Code -  - This shows you the code of 
whatever you have clicked on in the preview. You can edit 
the code here and click 'Apply' to see the effect on the 
preview.  

At the bottom of the Design tab are three main tabs where you can 
change between the Page Preview tab, the Layout Code tab and the 
Details tab (where you can edit names, descriptions, etc.) 

 

You can also click the  button to see the preview and the layout 
code at the same time. 

Down the right-hand side of the Design tab is a narrow vertical panel 
that either contains the Content Tree or the 'Design Tree' - depending on 
what tab is chosen at the bottom of the panel. The Content Tree allows 
you to quickly change the section you are viewing in the Design tab. The 
Design Tree shows you all the layouts that make up the current page. 
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If you want to select a section to edit, use the Content Tree. If you want to 
edit a page that isn't a section (including email and style sheet layouts) 
then use the 'Select Page Type' drop down at the top left of the Design 
tab. 

 

Exercise - Changing Fonts 
This exercise will show you how to use the Design tab to change the 
appearance of the text in your store. 

1. Go to the 'Homeware' section. 

2. Click on the 'Teapot' product name in the preview. 

3. Click on the  icon in the preview toolbar to make the 
product name italicised. 

4. Click on the  icon and then choose an alternative colour 
for the product names. 

You can do this kind of text formatting for any text in the store. 

5. Now click the 'Undo' icon on the toolbar -  

6. This should reverse out the colour change. 

7. Now select a different colour. 

 

Notice that the change you made changed all the products on the page - 
this is because they are all using the same layout. It w ill also change the 
appearance of products in other sections in your store. 

More Information - Working With Dreamweaver 
Actinic comes w ith a Dreamweaver extension that allows you to supply a 
totally custom overall layout to Actinic, and also edit layouts using 
Dreamweaver. For more details on this, see the section in the main 
Actinic help called 'Working With Dreamweaver'. 
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Help With Design 
Designing in Actinic can take a little while to understand - this is just 
because there aren't that many programs that work in the way Actinic 
does. However, once you've learnt the basics, you w ill discover how 
flexible Actinic is to design with. 

The important thing is to spend a bit of time trying to understand how 
the various features work, before ploughing ahead and trying to make a 
specific change.  

These articles w ill lead you through the essential things you need to 
know. 

Using the Preview to Select a Layout 
Try clicking w ithin the preview panel in the Design tab. 

 

You should see a dotted line appearing round the thing you've clicked 
on. This means you've selected a layout (or an item w ithin a layout). 

Layouts are the building blocks of Actinic pages. They are pieces of 
HTML that Actinic sticks together in order to create each page in the 
store.  

It is possible to see the HTML code of the layout you've clicked on. To do 
this, look at the 'Layout Code' panel. This will either be underneath the 
preview, or it w ill be on a separate tab. 

 

In the title bar of the Layout Code panel is the name of the layout. 

 

Make a mental note of this, as it's useful to know what the layout is called 
in case you ever need to go back to it. 

Note: The  button on the layout code toolbar is used to toggle between 
an 'advanced' and 'simple' view of the layout code. You generally just 
leave it on the 'simple' view. 

Navigating Round the Layouts 
Once you have selected a layout in the Design tab, look at the layout 
breadcrumb trai l  that runs along the bottom of the Design tab.  
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The breadcrumb trail shows you that the layout you've clicked on is 
located within another layout 'above' it, and that layout in turn is located 
within another layout. So in the example above, the product layout is 
located within the product list, which in turn is located within the 
'section page' layout - and so on until you reach the 'top' of the design, 
which is a special layout called the 'Overall Layout' (also known as the 
'Outer Layout'). 

If you only see one layout in the breadcrumb trail, it's probably because 
you've already got the Overall Layout selected in the preview. 

You can cl ick on the layouts in the breadcrumb trail to select them, and 
this way you can move up in the design. 

You can also click the  button on the layout code toolbar and the  
icon in the preview to move up a level in the design. 

The down arrows are for taking you back to the layout you were on 
previously. 

You can see the full structure of the layouts used to build the page by 
viewing the 'Design Tree'. To see the tree, click on the tab at the bottom 
right of the screen. 

 

Page Structure 
All Actinic pages are divided into two parts - the 'outer' and the 'i nner'.  

·  The 'outer' part of the page controls the branding and 
navigation elements that largely stay the same as you go 
from page to page. They are the elements that usually go 
across the top and down the side of each page. The outer 
part of the page also contains the <head> section. 
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·  The 'i nner' part of the page controls the content for that page 
- so if it's a section page it w ill be the section links and 
products, and if it's a checkout page it w ill be the checkout 
fields etc. 

Outer Layout 

The outer part of the page is controlled by a layout called the 'Overall 
Layout' (also known as the 'Outer Layout'). This is the 'top' layout of each 
page - which every other layout is inserted within. 

Outer layouts always contain a pink/ purple placeholder called 
INNERLAYOUT, which w ill be replaced by the content (inner layout) 
for that page when the page is generated. 

You can select the overall layout within the Design tab by clicking 
anywhere within the preview, and then clicking the first layout on the 
layout breadcrumb trail. 

 

A lternatively, you can view the Design Tree and then click on the top 
item in the tree to select the overall layout. 

 

A ll the outer layouts are kept together in the library w ithin a group 
called 'Web Page Outer Layout'. 

 

You'll find out more about the library in a moment. 

Inner Layout 

The inner layout is harder to talk about as it w il l be different depending 
on which page you are looking at.  

For section pages, the inner layout w ill probably have a name that starts 
within 'Section Page...' and when you look in the code of it, you'll see lots 
of references to 'section lists' and 'product lists'. 
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Every 'type' of page has a different inner layout that controls the layout 
of its content. A ll the inner layouts used by the store are collected 
together in the library in a group called 'Web Page Inner Layout'. 

 

Editing and Undoing 
You can make a change to the HTML of a layout and then click the 
'Apply' button to see what effect this has on the store. 

 

The preview w ill be automatically updated when you click 'Apply'. 

If you are not happy with the results, cl ick the 'Undo' button on the 

toolbar to undo the change - . 

You can also edit layouts using Dreamweaver. This is described in the 
main help in a section called 'Working With Dreamweaver'. 

Remember when making changes that this layout is probably going to be 
inserted w ithin another layout, so be careful when making changes that 
you don't do anything that might distort or corrupt this 'parent' layout. 

If you have made a mistake with a layout, and you cannot work out how 
to get the layout working again then you can always revert the layout 
back to its 'factory settings'. This is described in the next section. 

The Library 
The Design tab allows you to edit the layouts that are used within a page, 
but the Library allows you to search through and edit al l  the layouts 
within Actinic. 

You can open the library by going to 'Design |  Library', then change to 
the 'Layouts' tab. 

Highl ighting the layouts you've edi ted 
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If you click the 'H ighlight edited l ibrary layouts (*)' checkbox at the 
bottom of the 'Layouts' tab, you will highlight any layouts you've 
customised, and new layouts you've created. 

Layouts you've customised will be marked w ith a (*) and have a  icon. 

You can also highlight any new layouts you've added by selecting the 
'H ighlight new user layouts (+)' checkbox. 

Searching for layouts 

Right-click anywhere within the Layouts tab and select 'Find'. 

 

You can search for the name of a layout or some code within a layout. 

Creating new layouts 

Right-click on a layout and select 'New Layout'. 

 

Give the layout a name and click 'OK'.  

Note: You can also create new layouts within the Layouts tab of a 
product/ section/ Site Options. Simply select the '<New>' option at the 
bottom of the drop down lists. 

 

Deleting layouts 

You can only delete a layout from the l ibrary if it's a custom layout that 
you've created, and you haven't selected it anywhere. 

Reverting to Factory Settings 

If you have made a mistake in a layout, and you want to put it back to 
how it was before you started making changes to it, then you can right-
click on it in the library and select 'Revert to Factory Settings'. 
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Layout selectors 

Layouts are only part of the picture. There are also round things called 

'Layout Selectors' -  - that control how layouts are listed within the 
'Layout' panels. 

 

You can edit these layout selectors to change which layouts are listed 
within Actinic, and in what order. 

Inserting Variables 
Variables are placeholders for Actinic data. When the pages are 
generated, the variables are replaced by real data. 

Variables in layouts look like this: 

 

Inserting a new variable is simple. Let's say you wanted to add a new 
link to your home page.  To do this, you might add the following HTML 
into the layouts: 

 

You can now place your cursor between the two quote marks and click 
the 'Insert Variable' button -  

The list of layouts is initially really long, but you can use the 'List names 
containing' fi lter the search.  If you enter 'Home' into the list, the list 
becomes: 
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You can now highlight 'HomePageURL' and click 'Insert'. 

 

Exercise - Including the 'Author' Variable into 
the Design 
Earlier on in this guide, you created a new 'Author' variable. This 
exercise will show you how to include it in the design. 

1. Go to the Design tab and then make sure you are looking at 
the 'Books' section. 

2. Click on the name of one of the books on this page. This 
should highlight the 'ProductName' variable. 

3. Add in a new blank l ine straight after the variable. 

4. In the new blank line, type <br  / > 

You might notice that Actinic prompts you here to complete the tag. This 
is a feature of Actinic - it w ill help you create the HTML within the 
layouts. 

5. Just after the <br  / > right-click and select 'Insert Variable'. 
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6. Select 'Author' from the list of variables that appears and 
click 'Insert'. 

7. Click 'Apply' and check the preview to see if your value have 
appeared. 

 

If the author value has not appeared for all your books, it may be because 
your books are using different layouts from each other. You may need to 
insert the <br  / >Aut hor  in more than one layout. 

Inserting Layouts 

To insert a layout, use the  button on the layout code toolbar. 

 

What you get presented with though is not a list of layouts - rather, you 
get a list of Layout Selectors (which you might have seen within the 
Library). 

The job of a layout selector is to insert a type of layout into the design. 
You can see these layout types in the 'Layouts' tab of the library. 

 

For example, inserting the 'ProductLayout' layout selector will insert a 
product layout into the design, and the 'AddToCartButton' layout 
selector will insert an add to cart button into the design. The actual 
layout that is used is controlled elsewhere - usually in Site Options. 
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If there is a specific layout that you know you want to insert, rather than 
just inserting any layout of a particular type, then you can select the 'Use 
Fixed Layout' button and select one from the list.  

 

Warning - using 'Fixed Layouts' means that you will no longer be able to 
change the layout in Site Options or in the Layout panel of your 
sections/ products. More details are in "Advanced: Fixed Layouts vs. 
Selectable Layouts" on page 90. 

Hiding Things With Conditions 
When you look in layouts, you see lots of green 'block  i f ' tags. 

 

These are condi tions, which will hide the text between the block tags 
unless a certain condition is met. You can view and edit the condition by 
double-clicking on the opening 'block if' tag. 

 

In the above example, the text shown is hidden unless the 'Author' field 
has a value. If the 'Author' setting doesn't have a value, then the whole 
thing is hidden. 

Using Stylesheets 
Actinic makes use of stylesheets to control layout and fonts in the store. If 
you want to change the layout of items on a page, or the default 
appearance of text, you wil l probably have to think about editing the 
main Actinic stylesheet. 

Note: You can edit the default font size and appearance in the 'General' 
panel of 'Site Options', and you can edit colours in the 'Color Schemes' 
tab of 'Design |  Themes'. 

Whenever you see a style used in Actinic layout e.g.: 

 

... you can right-click on the style and select 'Look Up In Stylesheet'. 



90  ····   Designing Your Store Getting Started Guide 

 

You can then edit the style as required. 

The layout that controls the stylesheet is called 'Actinic Stylesheet'. You 
can also select it from the 'Select Page Type' drop down list in the 
'Design' tab. 

 

Note: In the Library, you'll find the 'Actinic Stylesheet' layout within the 
'Web Page Outer Layout' group. 

You can use your own styles with Actinic. Either just add them to the 
bottom of the 'Actinic Stylesheet' layout, or save your stylesheet within 
the Actinic site folder and then use a tag similar to the following to add 
link your stylesheet in. 

 

This tag needs to go in the <head> section in the overall layout used by 
the site. 

If you right-click on an HTML tag in your layout that is using a tag from 
your custom stylesheet, and then select 'Look Up In Stylesheet', Actinic 
will open up your custom css file in your default CSS editor.   

Advanced: Fixed Layouts vs. Selectable Layouts 
In the section called "Inserting Layouts" on page 88 it talks about how 
when you insert a layout selector, you have a choice. 

·  You can insert a layout selector into the design, without 
specifying a specific layout - this is also known as using a 
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Layout Placeholder 

 

·  A lternatively, you can select a specific layout to insert into 
the design - this is known as a Fixed Layout 

 

Using Layout Placeholders 

When you insert a layout placeholder (rather than a fixed layout) it w ill 
insert a type of layout into the design. You can generally choose the 
layout to be inserted within the 'Layout' panel of 'Settings |  Site Options'. 

 

You can then often override this setting within the Layout panel of a 
section, or of a product. 

Not all layout selectors have a place of setting in Site Options. If you find 
one that doesn't, then you need to go to the 'Layouts' tab of 'Design |  
Library', and edit the layout selector there.  

 

Edit the 'Top Level Value' there in order to change the layout that will be 
inserted. 

Fixed Layouts 

When you insert a fixed layout, it effectively disables the layout selection 
options in 'Settings |  Site Options'. The choice of layouts is still there, but 
they w ill be ignored when the pages are built. 

To change a fixed layout into a layout placeholder, you can right-click on 
the pink layout name in layout code and select 'Edit Appearance'. 

 

In the screen that appears, set the 'Use Fixed Layout' option to 'No()' and 
click 'OK'. 

Advanced: Editing Lists 
As well as standard layouts, you will sometimes come across things 
called l ists. They look like this in the layout breadcrumb trail: 

 

Lists always have an orange link across the top of the layout code that 
says 'Click here to edit list layout settings': 

 

Lists work differently to other layouts. Their job is to insert a set of items 
into a page. Wherever you see a list of products, or a list of sub-sections, 
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or a list of best sellers, or a l ist of locations, somewhere in there a list w ill 
be controlling the placement of the items. 

Editing the list allows you to edit the HTML that goes at the start of a list 
of items, at the end of a list of items and around each individual item. 

To edit a l ist, click the orange 'Click here to edit l ist layout settings' text at 
the top of the layout, or click the 'Edit List Layout Settings' button. 

 

The 'Start of List' and 'End of List' fields here are self explanatory. It gets 
a bit trickier in the 'Edit Rows/ Columns' tab: 

 

Don't panic! This screen looks more complicated than it is. This is where 
you can control the code that goes before and after each item in the l ist.  
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Generally, you only have to worry about the 'M iddle Rows'. Only use the 
'First Row' and 'Last Row' settings if you want the first or last row to be 
different to the other rows. The 'No of items' is where you can set the 
number of columns in your list - but this only works if your list is a table. 
Otherwise, just leave this set to 'Dynamic'. If you see a variable within 
this field, it means you can set the number of columns in the 'Layout' tab 
of the section/ product you are currently editing.  

A lso, there are three sets of 'Before' and 'A fter' fields just in case you have 
multiple columns in your list and you want the columns to look different 
from each other. Most of the time you can just put the same code into 
each set of fields. 
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